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1 General Information
This program is used to communicate with GEOLON-Dataloggers via the RS232 interface
for interactive configuration and for displaying recorded data on the PC screen.

1.1 Operating Systems and related Issues
SendCom is a Java-application that works on both Linux and Windows operating systems.
The only prerequisite is that the Java Runtime Engine (JRE) is installed on the PC. We
recommend using our customized KNOPPIX-CD, which allows running Linux and
SendCom on most PC-configurations without the need to install Linux or SendCom on that
PC. However, if you want a permanent installation of SendCom, or want to use MS
Windows, just follow the steps below.

2 Installation

2.1 Obtaining the Software
SendCom can either be found on the Utility-CD supplied with  our data loggers, or it can
be downloaded from our website. Please copy the files to a folder on your local hardrive.

2.2 Installing on a Linux System

2.2.1 Unpacking the files
Unzip the file  sendcom_ver_x.xx.zip (if you already have installed java)

or    sendcom_ver_x.xx_java.zip (if you do not have installed java already).

This will produce a temporary hierarchy with a top level directory sendcom.
(E.g.:    /tmp/sendcom)

2.2.2 Java Installation
In order to use the SendCom software, J2RE (Java run time engine only) or J2SDK
(complete system development kit) must be installed on your computer. Please follow the
installations instructions in either 1.2.2.1. OR 1.2.2.2. according to your needs.

2.2.2.1 Installing for JRE, if not already installed
Please check whether a JRE is installed on your computer.  If not, you can get the JRE for
your version of Linux from  Sun Microsystems at:

http://java.sun.com/products/plugin/downloads/index.html

To install and configure Java in Linux, please follow the instructions provided at:

http://java.sun.com/j2se/1.4.2/jre/install.html
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For the purposes of this paper, it will be assumed that you have installed a JRE, which by
default is located in:

/usr/java/j2re1.4.2_04/

And java is then located in:

 /usr/java/j2re1.4.2_04/bin/

Check the path to your java-interpreter with "which java". If your setup is different, please
adjust accordingly. Please note, that newer versions of Java might have become available
meanwhile, which will also work with SendCom.

2.2.2.2 Installing for Java SDK, if not already installed
Please check, if  a SDK is installed on your computer.  If not, you can get the SDK for your
version of linux from  Sun Microsystems at:

http://java.sun.com/j2se/1.4.2/download.html

If you cannot get access to the sun site, you will find the corresponding file in the folder:

<sendcom>/drivers_4_linux/java/j2sdk-1_4_2_04-linux-i586-rpm.bin

To install and configure Java in Linux, please follow the instructions provided at:

http://java.sun.com/j2se/1.4.2/install.html

For the purposes of this paper, it will be assumed that you have installed the SDK, which
by default is located in:

/usr/java/j2sdk1.4.2_04/

And java then is located in:

/usr/java/j2sdk1.4.2_04/bin/

Check the path to your java-interpreter with   "which java". If your setup is different, please
adjust accordingly.

2.2.3 Installing the drivers

2.2.3.1 If you use JRE
Copy librxtxSerial.so to your <JRE>/lib/ext directory.

Example:
cp /tmp/sendcom/drivers_4_linux/librxtxSerial.so /usr/java/j2re1.4.2_04/lib/ext
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Copy RXTXcomm.jar to your <JRE>/lib/ext  directory.

Example:
cp /tmp/sendcom/drivers_4_linux/RXTXcom.jar /usr/java/j2re1.4.2_04/jre/lib/ext

2.2.3.2 If you use J2SDK:
Copy librxtxSerial.so to your <SDK>/jre/lib/ext directory.

Example:
cp /tmp/sendcom/drivers_4_linux/librxtxSerial.so /usr/java/j2sdk1.4.2_04/jre/lib/ext
Copy RXTXcomm.jar to your <SDK>/jre/lib/ext  directory.

Example:
cp /tmp/sendcom/drivers_4_linux/RXTXcom.jar /usr/java/j2sdk1.4.2_04/jre/lib/ext

2.2.3.3 Clean up installation files
You may now remove the installation files from the temporary folder

Example:
rm -R /tmp/sendcom

2.3 Installing on a Windows System (2000 or XP)

2.3.1 Unpacking the files
Unzip the file  sendcom_ver_x.xx.zip (if you already have installed java) or
sendcom_ver_x.xx_java.zip (if you do not have installed java already).  This will produce a
temporary hierarchy with a top level directory sendcom. (E.g.:    C:\sendcom )

2.3.2 Java Installation
In order to use the SendCom software, a J2RE  (Java runtime engine only)  must be
installed on your computer. Please follow the instructions in 1.3.3 if you don´t have a JRE
installed.

2.3.2.1 Installing JRE, if not installed already
Please check, if  a JRE is installed on your computer.  In the case it is not, then you can
obtain a JRE for your version of Windows from  Sun Microsystems at

http://java.sun.com/products/plugin/downloads/index.html

If you cannot get access to the sun site, you will find the corresponding file in the folder:
<sendcom>/drivers_4_windows/java/ j2re-1_4_2_03-windows-i586-p.exe

(E.g.:    C:\sendcom\drivers_4_windows\java\j2re-1_4_2_03-windows-i586-p.exe ) Please
note, that there might be newer versions of the Java Runtime Engine available from Sun
Microsystems. These will also work with SendCom.
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2.3.3 Copying the drivers
Copy rxtxSerial.dll to your <JRE>\bin directory.

Example:
(E.g.:  if you extracted the files into the folder    C:\sendcom  and java has been installed to
the default location )

copy c:\sendcom\drivers_4_windows\rxtxSerial.dll c:\Programme\Java\jre1.4.2_03\bin
(for German Windows)

copy c:\sendcom\drivers_4_windows\rxtxSerial.dll c:\Program Files\Java\jre1.4.2_03\bin
(for English Windows)

2.3.4 Copy RXTXcomm.jar to your <JRE>\lib\ext directory
Example:
(E.g.:  if you extracted the files into the folder C:\sendcom and java has been installed to
the default location )

copy c:\sendcom\drivers_4_windows\RXTXcomm.jar c:\Programme\Java\jre1.4.2_03\lib\ext
(for German Windows)

copy c:\sendcom\drivers_4_windows\RXTXcomm.jar c:\Program Files\Java\jre1.4.2_03\lib\ext
(for English Windows)

2.3.5 Copy sendcom.jar to your <sendcom> directory
If you already have a previously installed version of sendcom, just overwrite the
SendCom.jar file in your  <sendcom> folder. Otherwise, please create a new folder, e.g.
c:\Programme\sendcom

Example:
(E.g.:  if you extracted the files into the folder C:\sendcom )

copy c:\sendcom\SendCom.jar c:\Programme\sendcom
(for German Windows)

copy c:\sendcom\SendCom.jar c:\Program Files\sendcom
(for English Windows)

2.3.6 Delete temporary directory sendcom

2.3.7 Optionally, you can add SendCom.jar to your classpath:
set CLASSPATH=c:\Programme\sendcom\sendcom.jar;%classpath%
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3 Using Sendcom

SendCom starts up with a window like this:

The window frame and menu bar on your PC may look different from this, depending on
the settings of the desktop you are using,  e.g. Windows or Linux with Gnome, KDE, etc.

3.1 The Menu Bar

3.1.1 The File menu
The file menu allows uploading of system files to the GEOLON loggers, saving the logfile
to the local harddisk and leaving the programm.

3.1.1.1 Load
This function brings up a file selection window, where you can navigate to the location of a
firmware update, user programm or other system files for your GEOLON logger. The file
will automatically be transferred from the local drive to the logger´s storage device. You
can also use the drag & drop feature of your operating system by simply dragging the
desired file into the SendCom window.
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3.1.1.2 Save logfile
This functions brings up another file selection window, where you can select a destination
folder and filename for the SendCom logfile of your session on your local drives. The
Logfile will contain all commands and responses which have been issued so far.

3.1.1.3 Exit
This function terminates SendCom and clears the DTR signal for the GEOLON logger.
The same is achieved by clicking on the “close” box in the upper right corner of the
window.

3.1.2 The View menu
The view menu allows the selection of additional display areas and windows, which are
used less frequently in typical mission preparation sessions.

3.1.2.1 Show window
This is the most important additional window, since it  displays the aquisition data in
realtime from either of the recorders channels. The functions of the show window are
described in an own section of this manual.

3.1.2.2 System messages
When this option is selected, a new window area is displayed at the bottom of the main
window. Here you can find the current communication parameters and other system
information.

3.1.2.3 Status
When this option is selected, a new window area is displayed at the bottom of the main
window. If the system messages also are activated, the status window area will be placed
underneath the system message area.  The information displayed in this area reflects
internal parameters of the GEOLON logger and is usually only of interest for factory
maintenance and debugging purposes.

3.1.3 The Connect Port menu

3.1.3.1 COM1..[COMn] or /dev/ttyS0..[/dev/ttySn]
By default, SENDCOM uses COM1 (on Windows) or /dev/ttyS0 (on Linux) as its
communication port. If you want to connect to a different port, you can select the
appropriate port  here. Sendcom lists only those ports which are not currently occupied by
other applications, so your desired port may not show up at all. You may want to close
interferring applications to free the port and then use the “Rescan ports” to refresh the port
list.
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3.1.3.2 Rescan Ports
If you are missing COM-ports in the list of available ports, they might be occupied by other
applications. SendCom can only detect and list free ports, which are not occupied by other
programs. If you decide to free an occupied port, you must use the Rescan Ports function
to refresh the list of available ports to make the freed port available for SendCom.

3.1.4 The Help menu
The Help menu gives you information how to contact SEND Signal Elektronik GmbH for
support and other issues, as well as information that may be useful for us to solve these
issues.

3.1.4.1 About SendCom
This opens a new window, which displays our contact information like phone numbers,
email addresses  on the “About” page.  The  “Details” page gives information about the
version number of SendCom and the Java engine used for compilation.

3.2 The Command Window
The  command window is the main part of SendCom. All commands send to the GEOLON
device and its responses will be displayed here and written to the logfile when logging is
activated. Please consult your GEOLON manual for details about the possible
configuration procedures and commands. Commands are generally sent by typing them
on the computer keyboard, like it is done with a regular terminal program. Keystrokes will
not appear on the screen unless they have been properly received and echoed by the
connected device. Some functions and commands have been assigned to certain keys to
make things a bit easier. Please refer to the “function keys” section for details.

3.3 The Show Window
The show window displays the data of a single channel from a GEOLON recorder in
realtime. Though the window can be opened anytime from the view menu, it can only
display data after the appropriate command has been issued to the logging device.
Consequently, just issuing this command will also open the show window automatically.

The SHOW  command can be used to display the current signals of a selected channel.
SHOW may be used to check the proper operation of the sensor electronics prior to
starting an experiment.

Usage:
<string> SHOW
displays data of channel <string>, so <string> selects the channel to be displayed.
^C (ctrl-C) will terminate the command.

Example:
4 SHOW <enter>
This opens the show window (if not open already) and displays the data from channel
number four, as shown below.
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On the top menu bar of the show window, activated options are indicated by highlighting
the respective buttons. In the example displayed above, the option DOTS is activated.
DOTS sets the display to dots only. Other options are:

LINES: data points will be connected with lines
ANTIALIASING: evens out steps which are generated due to insufficient screen

resolution.
AC: in AC mode, any DC offset will be removed
NULL LINE: although the null line will be displayed as grey line already, this 

option activates a modus in which each second data dot will be set 
to null and marks the null line

PLUS: Amplifies current signal by a factor of 2
MINUS: Attenuates current signal by factor of 2
REDRAW: Redraws the screen, use in case of  display artifacts

Depending on the type of data logger connected, additional information will be displayed in
the information window on the right.

Due to the limited transfer rate of the RS232 interface, a delay in displaying the signals
can occur at sampling rates of 500 Hz and higher, also depending on PC properties. Not
all data can be displayed for these frequencies, resulting in a small time gap between two
redraws of the screen.
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3.4 Function Keys
In order to make frequently used commands better accessible, some of them have been
assigned to the function keys F1 to F12 on your PC keyboard. Again, some of these keys
are only needed for debugging and support issues by the SEND staff, the others speed up
typical mission preparation steps.

F1 Displays the list of function key assigned commands
F2 ?forth - For service purposes only
F3 1 load - For service purposes only
F4 application - For service purposes only
F5 hex - sets number display to hex
F6 decimal - sets number display to decimal
F7 boot - reboots data logger
F8 settings - displays the current settings of the data logger
F9 1 show - displays the current data from channel one in show window
F10 2 show - displays the current data from channel two in show window
F11 3 show - displays the current data from channel three in show window
F12 4 show - displays the current data from channel four in show window

3.5 Exiting the SHOW window and SENDCOM
Please click on the X button on the right top corner of the window for closing the SHOW
window. You can also press CTRL-C in the Command Window to close the SHOW
window.

To exit SENDCOM you can either click on the exit option in the file submenu or click on
the X button on the right top corner of the SENDCOM window.

4 Troubleshooting

4.1 Error: No Class Definition for SendCom
If you get the following error:

java -jar SendCom.jar
Exception in thread "main" java.lang.NoClassDefFoundError: SendCom

then you have not added the SDK to the classpath. Just add the SDK to the classpath, or
type on your command line:

<PATH_TO_J2SDK_BIN>/java -jar  SendCom.jar

Example:
/usr/java/j2sdk1.4.2_04/bin/java -jar  SendCom.jar



SendCom V2.2x

SEND GmbH, SendCom2.20a.mnl 12 of 13

4.2 Error: Illegal use of nonvirtual function call
If you get the following error:

Exception in thread "main" java.lang.VerifyError: (class:
gnu/io/RXTXPort$SerialOutputStream, method: write signature: ([BII)V) Illegal use of
nonvirtual function call
at gnu.io.RXTXPort.<init>(RXTXPort.java)
at gnu.io.RXTXCommDriver.getCommPort(RXTXCommDriver.java)
at javax.comm.CommPortIdentifier.open(CommPortIdentifier.java:547)

or something like that, then you can work around it by adding -noverify to your command
line.

Usage:
java -classpath  <PATH_TO_SENDCOM> -noverify
<PATH_TO_SENDCOM>/SendCom.jar

Example:
java -classpath  /usr/sendcom -noverify  /usr/sendcom/SendCom.jar

4.3 Error: Class Cast Exception thrown
If you get the following error:

java.lang.ClassCastException thrown while loading gnu.io.RXTXCommDriver

or a similiar error message, then you probably have to delete older versions of the com
drivers from your computer:

Example for Linux:
rm -r  /usr/java/j2sdk1.4.2_04/jre/lib/i386/libParallel.so

rm -r  /usr/java/j2sdk1.4.2_04/jre/lib/i386/libSerial.so

rm -r  /usr/java/j2sdk1.4.2_04/jre/lib/ext/jcl.jar

rm -r /usr/java/j2sdk1.4.2_04/jre/lib/javax.comm.properties

Example for Windows:
del  <path to java>/jre/lib/i386/libParallel.so

del <path to java>/jre/lib/i386/libSerial.so

del <path to java>/jre/lib/ext/jcl.jar

del <path to java> /jre/lib/javax.comm.properties
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4.4 Error: No Class Definition for EventListener
If you get this quite impressive error:

Exception in thread "main" java.lang.NoClassDefFoundError:
gnu/io/SerialPortEventListener
at java.lang.ClassLoader.defineClass0(Native Method)
at java.lang.ClassLoader.defineClass(ClassLoader.java:537)
at java.security.SecureClassLoader.defineClass(SecureClassLoader.java:123)
at java.net.URLClassLoader.defineClass(URLClassLoader.java:251)
at java.net.URLClassLoader.access$100(URLClassLoader.java:55)
at java.net.URLClassLoader$1.run(URLClassLoader.java:194)
at java.security.AccessController.doPrivileged(Native Method)
at java.net.URLClassLoader.findClass(URLClassLoader.java:187)
at java.lang.ClassLoader.loadClass(ClassLoader.java:289)
at sun.misc.Launcher$AppClassLoader.loadClass(Launcher.java:274)
at java.lang.ClassLoader.loadClass(ClassLoader.java:235)
at java.lang.ClassLoader.loadClassInternal(ClassLoader.java:302)

or something similiar, the drivers probably have not been installed properly. Please check
the <SDK>/jre/lib/ext directory for the presence of librxtxSerial.so and  RXTXcomm.jar . If
neccessary, repeat step 1.2.3 and, if required, 1.2.4.

4.5 SendCom will not start for a normal user
This applies to Linux users only:

- Change permissions for  /dev/ttyS*     or     /dev/tts/*  with the following  commands:
chmod g+rw /dev/ttyS* or chmod g+rw  /dev/tts/*
chgrp tty /dev/ttyS* or chgrp tty  /dev/tts/*

- Add your user to a group like /dev/ttyS* or  /dev/tts/*  (tty) with the kuser utility.

- Change permissions for /var/lock with the follwoing command:
chmod g+rw /var/lock

- Add your user to a group like /var/lock  (uucp) with the kuser utility.


